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User’s Manual
DesignDeck Embroidery

Software

Create with professional embroidery tools!
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Software/Systems Requirements

Windows Installation

Windows 8.1
Minimum System Requirements
    - Processor: 1 gigahertz (GHz)* or faster with support for PAE, NX, and SSE2

(more info)
    - RAM: 2 GB (64-bit)
    - Hard disk space: 20 GB (64-bit)
    - Graphics card: Microsoft DirectX 9 graphics device with WDDM driver

DesignDeck Embroidery Software Installation 
Before starting the installation, you must be logged on as the Administrator on your 
computer. This means that if you share the computer with someone else and have 
separate login ID’s, your ID must be the one named Administrator and allowed to 
install software on the computer.

Close all open programs. We suggest disabling your security software for the duration 
of the installation because anti-virus and anti-spam software can prevent installation. 
Please contact your security software provider to learn how to disable it.

To download the DesignDeck Embroidery Software click on the following link: 
http://sw-update.net/Coldesi/ColDesiSetup.exe. The executable setup file will 
download to Downloads folder. Double click on the icon to begin the install. Follow 
the prompts to complete the installation.
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At the welcome screen click on “Next”.

Read the License Agreement. (Scroll all the way down using the scroll bar on the far 
right of the screen). If you agree to the license agreement, click on “I accept the 
terms in the license agreement”.

Click on “Next.”
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Click the “Install” button on the bottom right to install the software.

Once installation is complete the window below will appear. Click the “Finish” button 
in the bottom right of your screen.

Proceed with the registration process to open the full functionality of the software!
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DesignDeck Embroidery Software Registration

The computer on which the software is installed must be connected to the Internet 
to complete the registration process. If you cannot connect to the internet on that 
computer, refer to the directions at the bottom of this section.

Before any designs may be saved, the software must be registered. Disable any 
anti-virus, ad-ware, and spy-ware software on your computer. We have found that 
these types of programs may affect embroidery software if they are active when 
you are registering. Disable your Windows firewall if it is on.

Double-click the DesignDeck Embroidery Software Icon on your Desktop to open 
the software program. Click on Help Tab and select Registration. The Welcome 
registration window opens.

Fill out the registration information completely. All fields with an asterisk are required.

1. Select from the drop down menu DesignDeck Embroidery.

2. Fill in your contact information completely.

3. Insert your 16-digit Serial Number. It must be typed in using all CAPITAL letters
and the dashes are required. This number is provided at the time of purchase;
refer to your email.

4. Click “Register Now”.

The software is now registered! The software is now fully functional.
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Additional Registrations

ColDesi DesignDeck software is licensed for one activation, so you can register 
immediately on one personal computer. The serial number cannot be reactivated 
after it has been registered. Two activations are permitted per serial number at any 
given time. To install the software on a second computer, request an additional 
activation from the Help Desk. If your computer must be replaced or Windows must 
be reinstalled, also open a Help Desk ticket to request assistance for an additional 
activation.

Software Transfer

Once registration is completed and the software is registered, you cannot transfer 
registration of the SOFTWARE to another person (either an individual or a single entity). 
This means you cannot sell, trade, or give the software to any other person. Activation 
codes will only be given to registered users of this software.

Instructions for Computer Software Registration without Internet

Using a different computer with Internet access, go to the web address below:

https://www.esoftwareondemand.com/ProductRegistration.aspx

1. Fill in all fields marked with an asterisk (*).

2. Provide the 16-digit serial number provided at time of purchase entering all as
letters in UPPERCASE in the “Serial Number” field. Dashes (-) are required.

3. Click “Submit.”

4. Contact a ColDesi DesignDeck Support Specialist to provide the necessary 
assistance to complete the installation.
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Quick Reference Icon Identification

To help you navigate through the software, we created this table for you to easily 
identify: (1) each icon; (2) what it does; and (3) applicable keyboard shortcuts and/
or mouse commands.

Icons
Icon Function Shortcut Location/Mouse Command

Selection Tool F7 Home Tab. Edit Box.

Edit outlines, 
Angle lines, 
Entry/Exit

F9 Home Tab. Edit Box.

Stitch Tool F10 Home Tab. Edit Box.

Path slice tool Home Tab. Edit Box.

Undo the last action Ctrl + Z Home Tab. Edit Box.

Redo the previously 
undone action

Ctrl + Y Home Tab. Edit Box.

Create a New 
Document

Ctrl + N Home Tab. File Box. Also, under 
“File” tab.

Open an Existing 
Document

Ctrl + O Home Tab. File Box. Also, under 
“File” tab.

Save the active 
document

Ctrl + S Home Tab. File Box. Also, under the 
“File” Tab and there is a “Save As” 
function.

Preview Print-put 
on screen

Home Tab. File Box. Also, under the 
“File” Tab and there are “Print” and 
“Print Setup” functions.

Send current design 
to embroidery 
machine

Home Tab. File Box. Also, under 
“File” tab.

Text Tool T Home Tab. Text Box.

Copy the selection 
and put it on the 
Clipboard

Ctrl + C Home Tab. Clipboard Box. Also a 
Right Click Function.

Cut the selection 
and put it on the 
Clipboard

Ctrl + X Home Tab. Clipboard Box. Also a 
Right Click Function.

Paste Clipboard 
contents

Ctrl + V Home Tab. Clipboard Box. Also a 
Right Click Function.
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Icon Function Shortcut Location/Mouse Command
Delete Selected Home Tab. Clipboard Box. Also a 

Right Click Function.

Zoom Tool Home Tab. Zoom Box. If you have 
a wheel on your mouse, the wheel 
will also control the zoom.

Fit Window * Home Tab. Zoom Box.

Zoom 1:1 / Home Tab. Zoom Box.

Pan Tool P Home Tab. Zoom Box.

Toggle drawing of 
stitches in realistic 
view

Ctrl + 3 Home Tab. Display Box. Also, in 
View Tab.

Ruler Tool R Home Tab. Display Box.

Select/Hide Hoop Home Tab. Display Box.

Slow Redraw 
Simulates Sewing

Ctrl + R Home Tab. Display Box.

Backdrop Tool Home Tab. Backdrop Box. The
Drop-down arrow allows you to select 
and define horizon and scale.

Show or hide the 
Backdrop image

Ctrl + B Home Tab. Backdrop Box. Also, in 
View Tab.

Input Run path 2 Home Tab. Digitizing Box.

Input Steil path 4 Home Tab. Digitizing Box.

Input Classic Satin 
path

9 Home Tab. Digitizing Box.

Input Complex Fill 
path

5 Home Tab. Digitizing Box.

Input Applique 
path

6 Home Tab. Digitizing Box.

Input Manual path 1 Home Tab. Digitizing Box.

Input Satin path 3 Home Tab. Digitizing Box.

Input Cross Stitch 
path

8 Home Tab. Digitizing Box.
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Icon Function Shortcut Location/Mouse Command
Input Note Home Tab. Digitizing Box.

Input Symbol Home Tab. Digitizing Box. The 
Drop-down arrow allows you to select 
from the Symbols catalog.

Magic Wand 
Create an outline 
over areas with 
similar color

Home Tab. Digitizing Box.

Input Artwork 0 Home Tab. Digitizing Box. The 
Drop-down arrow allows you to 
select shapes of artwork.

Rotate left 
selected paths

Modify Tab. Rotate/Flip Box. Rotate 
is also available in the Transform 
Tab in Properties Box.

Rotate right 
selected paths

Modify Tab. Rotate/Flip Box. Rotate 
is also available in the Transform 
Tab in Properties Box.

Mirror selected 
paths

Modify Tab. Rotate/Flip Box. Flip is 
also available in the Transform Tab 
in Properties Box.

Flip selected paths Modify Tab. Rotate/Flip Box. Flip is 
also available in the Transform Tab 
in Properties Box.

Left align 
selected paths

Modify Tab. Arrange Box. Right 
Click Option.

Right align 
selected paths

Modify Tab. Arrange Box. Right 
Click Option.

Top align 
selected paths

Modify Tab. Arrange Box. Right 
Click Option.

Bottom align 
selected paths

Modify Tab. Arrange Box. Right 
Click Option.

Vertical center 
align selected 
paths

Modify Tab. Arrange Box. Right 
Click Option.

Horizontal center 
align selected 
paths

Modify Tab. Arrange Box. Right 
Click Option.

Center align 
selected paths

Modify Tab. Arrange Box. Right 
Click Option.

Group selected 
paths

Ctrl + G Modify Tab. Arrange Box. Right 
Click Option.

Ungroup selected 
paths

Ctrl + U Modify Tab. Arrange Box. Right 
Click Option.
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Icon Function Shortcut Location/Mouse Command
Move selected 
paths to Front

Ctrl + Shift + [ Modify Tab. Arrange Box. Right 
Click Option 

Move selected 
paths to Back

Ctrl + Shift + ] Modify Tab. Arrange Box. Right 
Click Option

Trim selected 
paths

Modify Tab. Shaping Box. Right 
Click Option

Weld selected 
paths

Modify Tab. Shaping Box. Right 
Click Option

Intersect selected 
paths

Modify Tab. Shaping Box. Right 
Click Option

Distribute Horizontal 
Spacing

Modify Tab. Distribute Box. Right 
Click Option

Distribute Vertical 
Spacing

Modify Tab. Distribute Box. Right 
Click Option

Auto Digitizing Tools Tab. Create Box.

Stitched Snapshots 
Convert photos to 
embroidery

Tools Tab. Create Box.

Create multiple 
text designs

Tools Tab. Create Box.

Create cutting 
outlines

Tools Tab. Create Box.

Repeat the selected 
paths

Tools Tab. Create Box.

Repeat paths on a 
circle

Tools Tab. Create Box.

Place paths on a 
shape

Tools Tab. Create Box.

Reflect paths Tools Tab. Create Box.

Create random 
placement

Tools Tab. Create Box.

Optimize path 
sequence

Tools Tab. Create Box.

Optimize entry exit 
points

Tools Tab. Create Box.

Color sort selected 
paths

Tools Tab. Create Box.

Design Analysis Tools Tab. Create Box.
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Icon Function Shortcut Location/Mouse Command
Batch design 
conversion

Tools Tab. Create Box.

Editors Tools Tab. Other Box. The Drop-down 
arrow allows you to select Palette, 
Standard or Font Editors.

Show or hide grid View Tab. Display Box.

Show or hide 
Stitch Ends

View Tab. Display Box.

Show or hide  
Machine Commands

View Tab. Display Box.

Show or hide the 
Stitches

Ctrl + Shift + S View Tab. Display Box.

Show or hide the 
last stitch indicator

View Tab. Display Box.

Show or hide  
artworks, notes, etc

View Tab. Display Box.

Show or hide 
Stop/Start

View Tab. Display Box.

Auto lock stitch 
mode

View Tab. Display Box.

Show special 
folders

View Tab. Display Box.

Open the program 
general options

View Tab. Display Box.

Manual Display 
the documentation

Help Tab

Display program 
information, version 
number, and 
copyright

Help Tab

Today Display the 
start-up screen

Help Tab

Display the 
activation dialog

Help Tab

Check for product 
updates

Help Tab

Add color Bottom right corner

Remove Extra Bottom right corner
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Icon Function Shortcut Location/Mouse Command
Change palette Bottom right corner

Set Background 
color

Bottom right corner

Insert Needle 
Change

Bottom right corner

Insert Trim Bottom right corner

Design Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Artwork Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Applique Properties Only available when the Applique 
is selected in the Property Box. And 
“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Fabric Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Fill Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Run Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Steil Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box. Underlay Properties
“General Options” in View Tab

Underlay 
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Pull Properties “General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.
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Icon Function Shortcut Location/Mouse Command
Blend Properties “General Options” in View Tab if 

you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Column 
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

General 
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Advanced  
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Commands  
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Transform 
Properties

“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Text Tab
Properties

Only available when the Text is 
selected in the Property Box. And 
“General Options” in View Tab if 
you have “Show Property Tabs as 
Icons” checked, then this appears 
in the Property Box.

Eye Symbol Located in the Sequence Box. Indicates 
the color is visible. Left mouse click 
to make the color invisible.

Lock Symbol Located in the Sequence Box. Left 
mouse click on the icon to lock the 
stitches. No changes are made to 
the color when the lock is 
engaged.
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Design Page Overview

One of the features that makes DesignDeck Embroidery Software so user friendly, is 
that all the designing is done on a single screen. There is no flipping back and forth 
between program modules to design and view the outcome of your creativity.

1. Design Information: Provides stitch count, number of colors and design size.

2. Menu Options: The menu options allows access to the features of the program.

3. Rulers: Right click anywhere on the rulers to quickly change between Inches and 
Centimeters, adjust grid settings, show and remove guidelines, and center the 
design in the field.

4. Properties Box: Displays and allows editing of all the information about the
selected text, design, or object.

5. Sequence View Tab: Displays design sequence by color and objects within the colors.

6. Designs Tab: Allows easy, efficient display and access to designs placed in design
file(s) without having to search locations on the computer.

7. Effects Tab: Allows easy access to Outlines, Fill and Satin Stitches.

8. Navigation Tab: Allows access to zoom and pan tools.

9. Thread/Color Selection: Displays the information about colors and threads of 
elements in the design. It also allows for color changing, adding, and removing.

10. Open Design Tab(s): Multiple designs may be open at any one time. The current 
design name is designated with an X next to the name. To switch between open 
designs, click on the design tab.
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Menu Options
 

This is where the majority of your designing will be done. All the tools you need to create 
and modify are right at your fingertips! Simply click on these icons to begin your design.

General Options

Preface - It is not necessary to change the defaults in View Tab>General Options to 
use the software. These parameters are designed to provide each user with the software 
options particular to their machine and personal preferences.

The General Options box allows you to globally change many settings for the software. 
When you make a change in the General Options box it will keep these settings as default 
settings every time you open the software. In the General Options, you can make 
changes to the working environment, machine, grid settings, digitizing, viewing options, 
and color sorting.

To access the General Options box:

1. Select View Tab from the Menu Options.

2. Next, select General Options in the Settings box.
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Environment

1. Units: Select the preferred default, Metric or Inches. This may also be changed for 
immediate display by right clicking the ruler bar (top and left) of the display screen. 

2. Default Style: The style settings are preset stitch lengths, density, pull compensation, 
etc.; set to sew best on a specific material. 

3. Default Palette: The default palette is used when you are creating a new design. 
When loading a design that doesn’t have color information, there are numerous 
thread manufacturers to choose from. 

4. Auto match thread colors on loading stitch designs: If the option is checked, the 
software will auto-match any design to the “Default Palette” when you load a design.

5. Auto match thread colors on loading an outline design: When selected, the software 
will auto-match any design to the “Default Palette” when you load an outline design. 

6. Convert to outlines on loading stitch designs: If the option is checked, the software 
will allow you to create an outline on a design after it is loaded. 

7. Language: From the drop-down arrow choose from English, Chinese, Dutch, 
French, German, Italian, Polish, Portuguese, Russian, Spanish, or Korean.
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8. Autosave every (min): The default is 7. Change the default if needed.

9. Reset shell extensions: Reset to view the thumbnails/designs information in the file.

10. Export and Import Environment: Keep the specifications when digitizing a design 
with the design.

Note – Changes to any of the General Options may not apply to designs currently 
open. It will only apply to designs opened after the change has been implemented.

Machine

All machine settings are defined using the metric system, which is the standard in the industry.

 

1. Activate trim if stitch is longer than (mm): The software will automatically add a 
trim command to the design wherever a stitch is longer than 30mm (default). This 
is a user defined function and may be changed at any time. Function not available 
on all machines.
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2. Split up jumps longer than (mm): 12.0mm. The software automatically splits the 
distance between jumps to normal stitches of 12mm increments and inserts them. 
12mm is normally the maximum movement a sewing machine can move before 
a jump is needed.

3. Remove stitches shorter than (mm): This is used to clean up designs that are 
stitched too close. By turning on this function, the software automatically removes 
any stitches at 0.2mm (default) from the design. 

4. Combine jumps when reading: When a design is loaded, the software combines 
all jump stitches together; adding jumps only if needed. 

5. DXF Units: Select whether the measurement units in DXF files should be in Inches 
(default) or metric in the dropdown menu. 

6. Frame out location: This tells the frame out location what direction to move the 
pantograph, (Top, Bottom, Left or Right) when a frame out command has been 
inserted. Function not available on all machines. 
 
It is helpful to insert a frame out command after the placement stitching on an 
appliqué to allow more accessibility to the hoop without having to remove it from 
the machine.

7. Process borer movement when loading or saving: When selected, the borer 
movement is added when loading or saving the design.

8. Boring device movement: From the drop-down arrow select the commercial 
embroidery machine and the distance needed.

9. Add Stop to the end: When selected, a stop will be added to the end. 

Note – Changes to any of the General Options may not apply to designs currently 
open. It will only apply to designs opened after the change has been implemented.
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Grid

1. Horizontal Spacing: Set the horizontal spacing on the grid. Defaults to 10mm metric, 
or .50 inches.

2. Vertical Spacing: Set the vertical spacing on the grid. Defaults to 10mm metric, 
or .50 inches. 

3. Color: Select the color chip to change the color of the Horizontal and Vertical 
Spacing lines. 

4. Major Horizontally every (lines): Set the major horizontal lines on the grid. 
Defaults to 4. 

5. Major Vertically every (lines): Set the major vertical lines on the grid. Defaults to 4. 

6. Color: Select the color chip to change the color of the Horizontal and Vertical  
Major lines.

7. Dashed Lines Style: Set the style of grid to dashed lines (default). 

8. Solid Lines Style: Set the style of grid to solid lines instead of dashed. 
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9. Dots Style: Set the style of grid to dots instead of lines. 

10. Shape Styles: From the drop down arrow, select Rectangle, Diamond, or both.  
  Rectangle is the default.

11. Snap to grid: If selected, edit point to the closest grid point when created or  
  selected. 

12. Snap to guidelines: If selected, edit point to the closest guidelines point when 
  created or selected.

13. Snap to anchor points: If selected, edit point to the closest anchor points when 
      created or selected. 

14. Snap resolution (px): Change if you have a high resolution screen or want a
      higher resolution. The default is 10.

15. Show in front of design: If selected, the grid will show in front of the design.

Note – Changes to any of the General Options may not apply to designs currently 
open. It will apply to designs opened after the change has been implemented.

Digitizing
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1. Outline input mode: Click the down arrow to select one of three different
ways to create stitch outlines: Bezier, Simple draw, and Free hand.

Bezier - this is very common in vector artwork programs.
Instructions:
a) Left mouse click to plot your first point.
b) Left mouse click to create a straight line.
c) Left mouse click and drag to create a curved line.
d) Right mouse click after plotting your last point in order to set the structure.

Simple draw - this is the standard (default) mode for the software.
Instructions:
a) Left mouse click to plot your first point.
b) Left mouse click to create a straight line.
c) Left mouse click plus Ctrl on your keyboard to create a curved line.
d) Right mouse click after plotting your last point in order to set the structure.

Free hand - this is ideal for those using a tablet.
Instructions:
a) Left mouse click and hold while dragging your mouse (or touch the tablet

and move your cursor to create the line).
b) Release mouse click when done.
c) Right mouse click to set the structure.

Curve points as default: Check box to digitize with curved points.

Circular curves: Check box to create a perfect circle with only 5 points.
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2. Complex fill – Mode
a) Standard: Automatically applies the start point, end point and angle degree. 

This is the preferred option for new digitizers. All automatic aspects may still 
be altered.

b) Advanced: Requires user input of start and end points, and, depending on 
the stitch, the angle degree/direction.

3. Complex fill – Default angle: default 0°. Select the default angle of the stitches for 
digitizing in the Standard Mode. Click the down-arrow to select 0°, 45°, 90° or 135°.

4. Satin – Mode
a) Standard: Automatically applies the start point, end point and angle 

degree. This is the preferred option for new digitizers. All automatic aspects 
may still be altered.

b) Advanced: Requires user input of start and end points, and, depending on 
the stitch, angle degree/direction.

5. Satin – Use single line: Check to use a single line to input the satin stitch. See Satin 
Stitch section for more information.

6. Run – Mode
a) Standard: Automatically applies the start point and end point. This is the 

preferred option for new digitizers. All automatic aspects may still be altered.

b) Advanced: Requires user input of start and end points after digitizing the line.

Note – Changes to any of the General Options may not apply to designs currently
open. It will apply to designs opened after the change has been implemented.
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View

1. Highlight selection: When selected, this option will allow the user to turn “on” a 
highlighted color on a selected object. The color of the highlighted object may 
be changed, at any time, for easier editing. Click on the color chip to change the 
highlight color.

2. Accent color: The default is blue. Click on color chip to change. 

3. Show property tabs as icons: If the option is checked, the tabs in the properties 
box will be displayed as icons instead of names. This option eliminates/reduces 
scrolling across the tabs when viewing object properties. 

4. Auto backdrop panning: If selected, a backdrop will automatically move (pan) 
onto the design page if approaching an area of the backdrop that is not in view.

5. On screen text typing: If selected, a cursor will appear on the design page for text 
input instead of forcing input into the small text input box on the Properties>Text 
page. 

6. Show tooltip in input mode: If the option is checked, a box will appear near the input 
cursor when digitizing reflecting the current cursor distance from the last digitizing 
point/node.
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7. Show crosshair in input mode: If selected, a dashed line crosshair the full size of the 
digitizing page will display with the input cursor. This is especially helpful if trying to 
align points horizontally and vertically.

8. Auto close zoom and pan tools: If selected, this option will allow you to use the auto 
close zoom or pan tool and the Select Tool at the same time, allowing an object to 
be selected once zoomed in.

9. Use left click on palette to apply colors: If selected, this option will allow you to left 
mouse click on a color in the palette to apply to the design or element of the design.

Note – Changes to any of the General Options may not apply to designs currently 
open. It may only apply to designs opened after the change has been implemented.

Color Sort

Enter the maximum allowable color overlap per layer (%). The default is 5.

Note – Changes to any of the General Options may not apply to designs currently 
open. It may only apply to designs opened after the change has been implemented.
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File Tools 

The following tools generally apply to the entire design file.

Icon Function Shortcut Additional/Alternate  
Location Example/Notes

Create a New 
document

Ctrl + N Home Tab. File Box. Please see list of 
supported files

Open an existing 
document

Ctrl + O Home Tab. File Box. Please see list of 
supported files

Save the active 
document

Ctrl + S Home Tab. File Box. Please see list of 
supported files

Preview Print-out on 
screen

Home Tab. File Box. Also 
under the “File” Tab there is 
“Print”.

Send current design 
to embroidery 
machine

Home Tab. File Box.

File Formats
When saving a design for the first time it is very important to save the file using the .c2s format. 
This is the native format for DesignDeck Embroidery Software program.

The .c2s version of the file “remembers” all the features, stitch types, fonts, etc. of the design. 
Any time the design is re-opened to edit or change, it is best to use the .c2s format. It is a 
good practice to save and keep any file you may want to stitch again in the .c2s format.

After a file has been saved in .c2s; save it in the stitch format for the embroidery machine. 
Use the Save As feature to save the stitch file in the proper format for the machine and 
save directly to a memory stick for the machine to read. It is not necessary to keep a 
library of the designs in the stitch format. Any stitch format may be recreated from the .c2s 
file in the software.

Embroidery Design Formats Supported

ColDesi (C2S)
Library File (LDF)
Melco/Bernina (EXP)
Ricoma/Tajima (DST)
Tajima (DSB)
Tajima (DSZ)
Tajima (T01)

SWF (SST)
KSM (KSM)
Barudan (U01, U02. . .)
Barudan (DAT)
Barudan (T03)
Brother (PHC)
Toyota (10o)

ZSK (ZSK)
ZSK (T05)
Happy (TAP)
Juki (M3)
Singer (XXX)

Graphic Files Supported

Raster (including BMP, JPG, TIF, PNG, GIF) 
Vector (including AI, EMF, WMF) 
Scalable Vector Graphics (SVG) 

HPGL Plotter File (PLT) 
AutoCad File (DXF)
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Editing Tools 

The following tools control how text, designs, objects, and stitches may be edited, 
positioned, or otherwise manipulated. Additional instructions for select functions 
may be found in this manual.

Icon Function Shortcut Location Example
Selection tool F7 Home Tab. Edit box.

Edit outlines, Angle 
lines, Entry/Exit

F9 Home Tab. Edit box.

Stitch Tool F10 Home Tab. Edit box.

Path slice tool Home Tab. Edit box.

Undo the last 
action

Ctrl + Z Home Tab. Edit box.

Redo the previously 
undone action

Ctrl + Y Home Tab. Edit box.

Copy the selection 
and put it on the 
clipboard

Ctrl + C Home Tab. File box. Also a 
Right Click Function.

Cut the selection 
and put it on the 
clipboard

Ctrl + X Home Tab. File box. Also a 
Right Click Function.

Paste Clipboard 
contents

Ctrl + V Home Tab. File box. Also a 
Right Click Function.

Delete selected Home Tab. File box. Also a 
Right Click Function.

Rotate left selected 
paths

Modify Tab. Rotate/Flip box. 
Rotate is also available in the 
Transform Tab in Properties 
Box.  

Rotate right selected 
paths

Modify Tab. Rotate/Flip box. 
Rotate is also available in the 
Transform Tab in Properties 
Box.   

Mirror selected 
paths

Modify Tab. Rotate/Flip box. 
Mirror is also available in the 
Transform Tab in Properties 
Box.

 

Flip selected paths Modify Tab. Rotate/Flip box. 
Flip is also available in the 
Transform Tab in Properties 
Box.
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 Select Tool

To change size, dimension, or position of design, it must be selected. “Selected” 
means the software is ready to apply changes you institute. Also, once a design is 
selected with the Select Tool, you will be able to use Right Click Options.

Notice the boundary box around the design with shape nodes.
The Purple Circles, located in the upper right hand corner and lower left hand corners 
of the box, rotate the design clockwise or counterclockwise.
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To use the Purple Circle adjustment tools:

1. Position your cursor over the Purple Circle located in the upper right-hand
corner of the text box or lower left-hand corner.

2. Left mouse click and hold while dragging your cursor either to the left or right.

3. Release the mouse click when you reach the desired position.
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The Black X in the center allows you to move the design around. To use the Black X 
placement tool:

1. Position your cursor over the Black X.

2. Left mouse click and hold while dragging your cursor.

3. Release the mouse click when you reach the desired position.

To change the size and proportion of the design, use the black handles/nodes.
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The black handle/nodes on the corners of the boundary box allow for sizing proportionately 
larger or smaller. In the sample, the original design was made smaller by dragging 
the top left node diagonally toward the center of the design.

1. Position the cursor over a corner black handle/node.

2. Left mouse click and hold while dragging the cursor away from the design to 
enlarge. Drag the cursor into the design to make it smaller.

3. Release the mouse click at the desired size.
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The black handles/nodes on the left and right sides of the boundary box allow you 
to resize the design inward or outward horizontally, “stretching” the design. To use 
the horizontal adjustment handles/nodes:

1. Position the cursor over a handle/node located on either side of the select box.

2. Left mouse click and hold while moving either side handle/node horizontally.

3. Release the mouse click at the desired position.
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The nodes/handles on the top and bottom of the boundary box resize the design 
vertically. To use the vertical adjustment handles/nodes:

1. Position the cursor over one of the vertical adjustment handles/nodes.

2. Left mouse click and hold while moving the cursor up or down.

3. Release the mouse click at the desired position.
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Right-Click Shortcut Feature

To quickly access the View features, Cut, Copy, Paste, Duplicate, Insert, Delete, 
Convert To – Manual, Run, Satin, Steil, Cross Stitch, Applique and Artwork; Utility – 
Create Border, Create Outline, Simplify, Create Nap Blocker and Change Style; 
Align Tools, Group, Ungroup, Distribute Tools, Order Tools, and Transform features, 
left-click to select an object. While the object is selected, right-click to open the 
Right-Click Shortcut drop-down menu. Left-click the desired function to access its 
features.

The Right-Click Shortcut features may change depending on the type of design, 
including text or artwork selected.

View
Use this for view options for the design, such as, Lock, Unlock All, Show All, Hide All, 
Filter and Fade Hidden. To use, select an object and then right mouse click and select 
“View” where the available options will be displayed.

Cut
Use this to cut the selected design element. To use, select an object and then right 
mouse click and select “Cut.” This will remove the selected object from the project, 
but put it in memory to be pasted somewhere else. (Icon available.)
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Copy
Use this to copy the selected design element. To use, select an object and then right 
mouse click and select “Copy.” This will create a copy of the selected object to be 
pasted into the project. (Icon available.)

Paste
Use this to paste the cut/copied element. To use, select an object and then right 
mouse click and select “Paste.” This will paste a copy of the cut or copied element 
onto the design page. (Icon available.)

Duplicate
Use this to duplicate the selected object. To use, select an object and then right 
mouse click and select “Duplicate.” This will duplicate the selected element onto 
the design page.

Insert
Use this to insert a copy of the selected element (places right after copied object). 
To use, select an object and then right mouse click and select “Insert.” It will insert a 
copy of the selected element.

Delete
Use this to delete the selected element. To use, select an object and then right 
mouse click and select “Delete.” This will delete the selected object.

Convert To
Click this option to display a list of different options for converting the selected object(s). 
Please see Digitizing section for additional information.
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Utility Tool
Use this option to Create Border, Create Outline, Simplify, Remove Overlaps, Create 
Nap Blocker, and Change Style. To use, select an object and then right mouse click 
and select “Utility” and the option. See below for specific options.

Create Border
Use this to create a run stitch border around the inside and outside edges of
a filled object. To use, select the fill stitch and then right mouse click and
select “Utility” and then “Create Border.”



36 DesignDeck Embroidery 37DesignDeck Embroidery

Create Outline
Use this to create an artwork line(s) either outside or inside of the selected
object. If more than one object is selected, it will be treated as a single
object without having to combine or group it.

To use, select an object(s), right click, and select the “Utility” and then “Create
Outline” option to display the dialog box.

Distance (in): Default 2.0mm. Enter the distance of the outline from the edge
of the object(s) selected.

Repeats: Default 1. Enter the number of repetitions to create. Each one will
be the same distance from the previous line as entered above.

Inside: Default unchecked. Check to place the outline on the interior of the
selected object(s).

Join repeats: Default unchecked. This will create one continuous outline,
instead of multiples of the same shape.

Unite outlines: Default checked. This option is for future development.

Joins: Default is square. Select drop-down arrow for round or miter option.

Fill area: Default unchecked. This option will fill the area including exterior if
checked.

Remove Selection: Default unchecked. This option will create the designated
outline, and then remove the original selected object(s).
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Geometric Echo: Default unchecked. This option will create an echo of the
geometric shape of the object.

Use this option to create a stippled area around a design by combining the outline 
with an artwork perimeter (from an artwork block or drawn in artwork). Or create an 
applique. The resulting area may be converted to hundreds of stitch choices.

Create Nap Blocker
Use this to create a stitch under and extending out around the design to lay
down the nap of the fabric.

To use, select an object(s), right click, and select the “Utility” and then “Create
Nap Blocker” option to display the dialog box.
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Distance (in): Default 4.0mm. Enter the distance of the nap blocker from the
edge of the object(s) selected.

Change Style
The style settings are preset stitch lengths, density, pull compensation, etc.; set to 
sew best on a specific material.
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Align
Use this to align objects left, horizontal center, right, center, top, vertical center, and 
bottom. To use, select multiple objects and then right mouse click and select “Align.” 
Next, select the type of alignment you want to use from the list. (Icons available.)

Group
Use this to group selected elements together. To use, select multiple objects and 
then right mouse click and select “Group.” This will group together all the selected 
objects. (Icon available.)

Ungroup
Use this to ungroup grouped elements. To use, select the grouped objects and then 
right mouse click and select “Ungroup.” This will ungroup the grouped objects. (Icon 
available.)

Distribute
Use this to distribute space evenly horizontally or vertically. To use, select multiple 
objects and then right mouse click and select “Distribute”. Next select the type of 
distribute you want to use from the list. (Icons available.)

Order
Use this option to move the selected object to the Front of the design where it will 
be stitched last in the stitching sequence, or to the Back of the design where it will 
stitch first. Backward and Forward are also available, which moves the selected 
object back one or forward one. To use, select an object and then right mouse click 
and select “Order” where the available option(s) will be displayed.

Transform
Use this to access the transform tab from the properties box. To use, select an object 
and then right mouse click and select “Transform.” This will open the Transform box in 
the properties box where the object may be resized and rotated, among other options.

 Shape Tool
Select an object with this tool to edit the outlines, angle lines and start/stop points.
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 Stitch Tool
This tool works much like the select tool, but at the stitch level. Under View Tab, show 
Stitch Ends to make easier to see and select stitches. Left click on a stitch to select it. 
It can be moved.

Hold down the left mouse button to drag a box around a group of stitches.
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While stitch is selected, right mouse click for additional options.

 Slice Tool
Use this tool to split an object into two or more objects.

In the example, a heart was drawn with the artwork tool. Right mouse click and Convert 
to Complex Fill. Select Slice Tool, left mouse click and hold on one side of the heart, 
drag to opposite side, and let go of mouse click. Select Enter on keyboard.
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Left mouse click on Select Tool and Right-click to bring up options box.

Select Break Apart. Move bottom of heart away from top of heart.
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 Text

How to Create
1. Select the Text tool.

2. Left mouse click on the design page (A Letter “A” will appear on the design page).

3. In the “Properties Box”, select the letter A in the text input box.

4. Using your keyboard, type the name, message, etc. to add to the design page.

5. Next, set the text properties such as height, font style, etc.

6. Click Apply to display the text on the design page.

Text with On-screen Typing
This option must be checked in the View Tab, Settings box>General Options>View screen.

1. Select the Text tool.

2. Left mouse click on the design page. A flashing vertical line will appear inside selection
handles.

3. Using your keyboard, type the name, message, etc. to add to the design page. It is also
possible to cut and paste from other documents.

4. Next, set the text properties such as height, font style, etc.

5. Click Apply to display the text property changes on the design page.
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Circular Text
Create text using either of the above methods.

1. In Properties – Text, click the arrow to display the Type drop down box.

2. Select the “Circle” option.

3. Click Apply.
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Text on Spiral
Create text using either of the above methods.

1. In Properties - Text, click the arrow to display the Type drop down box.

2. Select the “Spiral” option.

3. Click Apply.
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Monogram Text
Create text using either of the above methods. For a traditional monogram, the last name 
is the center letter. Only use 3 letters for the monogram.

1. In Properties - Text, click the arrow to display the Type drop down box.

2. Select the “Monogram” option.

3. Click Apply.

The main characteristic of these fonts in a traditional monogram look are often seen on 
shirts, linens, and accessories.

The Monogram fonts are designated in the Font Library with an upper case M preceding 
the font name.
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Text on Path
Create text using either of the above methods.

1. In Properties – Text, click the arrow to display the Type drop down box.

2. Select the “Path” option.

3. Click Apply.

Vertical Text
Create text using either of the above methods, keeping in mind the letters will appear in a 
vertical row.

1. In Properties - Text, click the arrow to display the Type drop down box.

2. Select the “Vertical” option.

3. Click Apply.
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Tip: For best font selection, position the cursor over the font type box to display all of the 
character options and size recommendations for that font.

Editing Text
When using the Text icon and adding text to the design page, you will notice the appearance 
of the text on the screen. You will see your text with several “nodes” of different colors surrounding 
the text and there will be a purple text box around all the letters. Each has a specific meaning 
and function.

You will know that the text icon is in use because

1. The letter “A” will appear near the cursor.
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2. A Purple Box will surround the text and specially shaped and colored Nodes will appear
within your text.

3. The Text Tab in the Property Box will appear.

The Black Boxes located at each of the four corners of the text box, allows the adjustment 
for the height of the text up or down at each given corner.

To use the Black Box adjustment tool:
•	 Position the cursor over the black box.
•	 Left mouse click and hold while dragging the cursor up or down.
•	 Release the mouse at the desired position.

The Black Diamond, located in the center of each letter, allows for movement of the given 
letter into any location in the work area.

To use the Black Diamond adjustment tool:
•	 Position the cursor over the Black Diamond in the middle of the letter to move.
•	 Left mouse click and hold while dragging the cursor to the desired location.
•	 Release the mouse click at the desired position.
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The Blue Diamond, located between each letter, allows you to shift all letters located to 
the right of the blue diamond to the left or right (in the example above, the text was shifted 
to the right of the letter “T.”

To use the Blue Diamond adjustment tool:
•	 Position the cursor over the Blue Diamond located to the left of the letters to shift to 

the right or left of their current location.
•	 Left mouse click and hold while dragging the cursor to the desired location.
•	 Release the mouse click at the desired position.

 

The Black Diamond, located in the upper left-hand corner of the text box, allows for making 
the text proportionately larger or smaller (in the example above, the text was made smaller).

To use the Black Diamond (upper left-hand corner) adjustment tool:
•	 Position your cursor over the Black Diamond located in the upper left-hand corner of 

the text box.
•	 Left mouse click and hold while moving the cursor to the desired location (move up 

and to the right to make the text larger, move down and to the right to make the text 
smaller).

•	 Release the mouse click at the desired position.
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The Black Diamond, located in the lower right-hand corner of the text box, allows you to 
move the text inward or outward along the axis (notice in the example above that the 
text stretches outward but the height of the text does not change).

To use the Black Diamond (lower right-hand side) adjustment tool:
•	 Position your cursor over the Black Diamond located in the lower right-hand corner of 

the text box.
•	 Left mouse click and hold while moving the cursor either to the left (makes text narrower) 

or to the right (stretches the text wider).
•	 Release the mouse click at the desired position. 
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The Green Circle, located in the upper-middle and lower-middle of the text box, allows 
you to move the text inward or outward in an envelope manner (notice in the examples 
above that the text stretches inward, outward, or both while the edges stay in the same 
position).

To use the Green Circle adjustment tool:
•	 Position the cursor over the Green Circle located in the upper-middle or lower-middle 

of the text box.
•	 Left mouse click and hold while dragging the cursor either inward or outward.
•	 Release the mouse click at the desired position. 
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The Purple Circle, located in the upper right-hand corner of the text box, allows you to 
rotate the text to the left or right.

To use the Purple Circle adjustment tool:
•	 Position your cursor over the Purple Circle located in the upper right-hand corner of 

the text box.
•	 Left mouse click and hold while dragging your cursor either to the left or right.
•	 Release the mouse click when you reach the desired position.
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Backdrop Features
Load a backdrop image
The backdrop may be any raster, or bitmap, image such as .bmp, .png, or .jpg; it does not 
have to be a professionally created vector art file. Naturally, a cleaner and clearer image 
will produce a better result with the magic wand. It is possible to use image files saved (or 
exported) from quilt design programs, scanned from pattern sheet or a photograph of the 
finished product. Be careful to respect any licensing and/or copyright restrictions.

Select the Backdrop icon, . Select the image to be used.

Set the horizon
To straighten an image that is crooked, click on the slide out menu bar of the Backdrop 
Icon and select Define Horizon. The cursor will become a + sign. Use any straight line parallel 
to the top or bottom of the screen, and drag the cursor across while holding down the left 
mouse key.
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When the mouse button is released, the image aligns to the new horizon. It is helpful to turn 
on the grid lines to verify the image is straight.

Set the Scale
If the image has a border, or the image needs to be resized based on a portion of the 
image, the transform feature will not be accurate. Transform resizes based on the total 
image size. Use the Define Scale to determine the size of the image on a portion of the 
image. Click on the slide out menu bar of the Backdrop Icon and select Define Scale. 
Click to set the cursor on the left side of the portion to measure, drag to the right side.
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When the mouse button is released, the scale measurement window displays.

Enter the correct measurement for the portion selected and click OK. The image is resized 
based on those proportions. The image properties will still reflect the full size of the image.

Both of these options are repeatable when the Backdrop Icon is selected.
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Digitizing Tools
The following tools create stitch objects, artwork, and stitches in different types and formats 
which are further defined in the properties box and with editing tools. Additional instructions 
for select functions may be found in this section of this manual.

Icon Shortcut Function Description
1 Input Manual Path Input stitches where each click is a 

stitch, not a node to be filled in by run 
stitches.

2 Input Run Path Select this icon to input a run stitch path.

3 Input Satin Path Input a column of stitches of varied 
width.

4 Input Steil Path Input column stitches of uniform thickness.

5 Input Complex Fill Path Input complex fill stitches to fill the shape.

6 Input Applique Path Select to manually digitize a path for
a fabric applique. The process creates
the placement, tackdown and cover
stitches.

8 Input Cross Stitch Path Convert any object or artwork to a fill of 
cross stitches.

9 Input Classic Satin Path Manually digitize a satin stitch path by 
clicking to input opposing points on each 
side of the object. The input points create 
the angle lines.

Magic Wand Create an outline over areas with similar 
color.

Input Note Add text to design page for instructions or 
additional information about the design

0 Input Artwork The Drop-down arrow allows you to select 
shapes of artwork.

Input Symbol The Drop-down arrow allows you to Input 
a symbol or Select from a catalog of 
symbols.
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 Artwork
Artwork is simple shapes that you can create for design or reference. They are simply images 
and not stitches; therefore, they will not stitch out. Any artwork may be easily converted to 
stitches by right clicking on artwork, selecting Convert to and the stitch. (See Right Click Options> 
Convert to.)

There are twelve shape options available with the menu in the Artwork icon tool.

Pen
Use the pen for drawing line art and tracing around background shapes. The pen has 
multiple input methods. The default method is assigned in General Options>Digitizing.

Bezier 
Click the left mouse button to add a point. Hold down the left mouse button after the 
first point is added (to make curves). 

Hold down the “Shift” key and then click the left mouse button to create horizontal 
lines up/down, left/right and a 45 degree angle.

Simple Draw
Click the left mouse button to add a point. Hold down the “Control” key after first 
point is added (to make curves).

Hold down the “Shift” key and click the left mouse button to create Horizontal lines 
up/down, left/right and a 45° angle.

Free Hand 
Click and hold the left mouse button to add a point. Drag the cursor across the 
screen to draw an image.
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Rectangle
The rectangle creates a four-sided parallelogram or a square.
1. Click and hold the left mouse button to create a rectangle.
2. Hold down the “Control” key and click the left mouse button to create a perfect square.

Ellipse
The ellipse tool creates circular and oval shapes.
1. Click and hold the left mouse button to create an ellipse.
2. Hold down the “Control” key and click the left mouse button to create a perfect circle.

Triangle
The triangle tool creates an isosceles triangle, a triangle with two equal sides and two equal 
angles.
1. Click and hold the left mouse button to create a triangle.
2. Hold down the “Control” key and click the left mouse button to create an isosceles triangle.

Diamond
The diamond tool creates a parallelogram on point. It is similar to the rectangle tool, but at 
a 45° angle.
1. Click and hold the left mouse button to create a diamond.
2. Hold down the “Control” key and click the left mouse button to create a perfect quadrilateral

rhombus, or square on point.

Star
The star tool creates 5-point star shapes.
1. Click and hold the left mouse button to create a star.
2. Hold down the “Control” key and click the left mouse button to create a perfect 5-point star.

Round
The round tool creates a four-sided parallelogram or a square with rounded corners.
1. Click and hold the left mouse button to create a round rectangle or square.
2. Hold down the “Control” key and click the left mouse button to create a perfect round

square.

Hexagon
The hexagon tool creates a six-sided rounded polygon shape.
1. Click and hold the left mouse button to create a six-sided polygon.
2. Hold down the “Control” key and click the left mouse button to create a perfect six-sided

rounded polygon.

Leaf
The leaf tool creates an oval leaf shape.
1. Click and hold the left mouse button to create a leaf.
2. Hold down the “Control” key and click the left mouse button to create a more rounded leaf.

Heart
The heart tool creates a heart shape.
1. Click and hold the left mouse button to create a heart.
2. Hold down the “Control” key and click the left mouse button to create a perfect heart.
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Flower
The flower tool creates a flower shape.
1. Click and hold the left mouse button to create a leaf.
2. Hold down the “Control” key and click the left mouse button to create a perfect flower.

Spiral
The spiral tool creates different types of spirals: single, swirl, double or double swirl. A dialog 
box appears to select your options.

1. Click and hold the left mouse button to create a spiral.
2. Hold down the “Control” key and click the left mouse button to create a perfect spiral.
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Creating Stitches

 Manual Stitches
Manual stitches are created by clicking the mouse button for every needle drop. Uses include:

1. Creating manual lock stitch
2. Random detail work
3. Small intricate stitching

How to create
In the following example, every number represents a left mouse click in sequence. After click 6, 
a right mouse click ends the sequence.

Manual Stitch Properties
Since the stitches are all of random length determined by the digitizer, there is not a properties 
box for manual stitches.

 Run Stitches
Run stitches are used in many different ways when digitizing, such as outlines, travel stitches, 
shading, small details, etc. Run stitches have eight different types:

1. Standard
2. Two ply
3. Bean
4. Motif
5. Symbol
6. Projection
7. Double Rope
8. Triple Rope
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How to create
Run stitches are created by left clicking along a path. In the image below, each number 1-6 is a 
left click. The sequence ends with a right click. Each of these clicks is represented by a small blue 
square which is called a node.

Once the path is finished, it is replaced with a straight stitch with needle drops equidistant apart, 
based on the stitch length in the properties box.

Standard
Standard, default, is a straight stitch with needle drops equidistant apart, based on the stitch 
length in the properties box.

Two Ply
A two ply run stitch is a standard run stitch which is stitched twice.
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Bean
A bean stitch is a run stitch that repeats on itself a designated number of times before moving to 
the next stitch.

Motif
Motif is a decorative run stitch with 99 different patterns to select.

Symbol
Symbol is a small, charm stitches only design. Choose from a catalog of designs.
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Projection
Projection allows your design to be dimensional.

Double Rope
A double rope stitch is two stitches twisted together forming a rope like stitch.

Triple Rope
A triple rope stitch is three stitches twisted together forming a rope like stitch.
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 Steil Stitch
The Steil Stitch creates a column of uniform thickness/width; a balanced satin stitch in sewing terms.
It has many applications:

1. Bold outlines and borders
2. Appliqué finishes
3. Finishing raw edges, like patches
4. Detailing on fill stitches

How to Create
A steil stitch is created in the same manner as a Run stitch. Any run stitch may be easily 
converted to a steil stitch and vice versa. (See Right Click Options>Convert to.) The angle 
of the column stitch is automatically calculated.

 Classic Satin
The “Classic Satin” tool is also used for creating columns of varying width, but in a
different manner than the Satin tool. A column stitch is a stitch that travels from
side to side rather than in a straight line. Uses of a satin stitch include:

1. Text
2. Borders
3. Column Stitches
4. Filling a small area
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How to create
The Classic Satin is created by alternating input on either side of the shape. These alternating 
nodes also determine the initial angle lines. In this example, a backdrop was loaded, as a 
guide for the shape of this leaf. The blue box numbers represent the left click sequence. The 
yellow lines are the angle lines of the satin stitch. There must be a corresponding point on the 
opposite side of the shape for each left click.

When the shape is complete, right click to set the stitches.

 Complex Fill
A complex fill comes in hundreds of varieties. It is used to fill large areas, create different 
textures, for large lettering and even for quilting.

How to Create
Select the complex fill icon and draw the object using the drawing method of choice. The 
drawing will automatically connect the beginning and ending points to close the opening.

By examining the nodes and start/end points of a filled shape without stitches, the object is 
easily understood.
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Select the object with the Shape tool. The start and end points can be moved, angle lines can 
be adjusted. Right click to add and edit points and path.

The effects on the fill stitches vary by stitch type and can create dynamic texture, rather 
than a flat two dimensional object. For example:

Fill Type: Standard
Pattern: Corn
Standard – This is the basic complex fill type. It includes several patterns from the drop-down 
arrow. Move the angle line for the stitch to look different or change the size of the pattern 
for smaller or larger shapes by changing the density and stitch length.
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Fill Type: Emboss
Pattern: 205
Emboss – This fill creates an embossed look with lots of different patterns from the drop-down 
arrow. Move the angle line for a different look or change the size of the pattern for smaller 
or larger shapes by changing the density and stitch length.

Fill Type: Motif
Pattern: 154 - Heart
Motif – This fill has many stitch type patterns from the drop-down arrow. Move the angle 
line for the stitch to look different or change the size of the pattern for smaller or larger 
shapes by changing the density and stitch length.
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Fill Type: Shape
Pattern: 104 – Heart
Shape – Move the center of the shape, by relocating the pink dot anywhere inside, or outside 
of the, the fill perimeter.

Fill Type: Echo
Pattern: none
Echo – This fill echoes the perimeter of the shape. Effects may be adjusted by changing 
the density and stitch length. 
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Fill Type: Contour
Pattern: none 
Contour – This fill follows the contours of a shape to the center, creating a curved, light-
and-shade effect. Effects may be adjusted by changing the density and stitch length.

Fill Type: Stippling
Pattern: Maze
Stippling – This is a meandering run stitch that may be adjusted by changing the stitch 
length and density. The smaller the density the tighter the stipple stitches.
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Fill Type: Wave
Pattern: none
Wave – This stitch has an angle line that is curved. The curve is adjustable by moving the 
nodes, changing the node angles, and even adding additional points with a right click on 
the angle line.

Fill Type: Grid
Pattern: Single
Grid – This fill creates a grid effect in the shape. Options include single, double, or triple. 
Move the angle line for the stitch to look different or change the size of the pattern for 
smaller or larger shapes by changing the density and stitch length.
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Fill Type: Radial
Pattern: Random

Radial - This stitch fill radiates out from the center. There are several patterns to choose 
from the drop down arrow. The larger the density, there is more space between the lines.

For representation of the fill stitch, always view it in Realistic View.

 Satin Stitch
The “Satin Tool” is used for creating columns of varying width. A column stitch is a stitch 
that travels from side to side rather than in a straight line. Uses of a satin stitch include:

1. Text
2. Borders
3. Column Stitches
4. Filling smaller areas

How to create
This Satin option has two methods of creating stitches.
A. In the image below, the Satin tool has been selected and the left clicks 1-6 represent 
one side of the path. After click 6, right click to designate the first side of the path is complete. 
Then the opposite side of the shape is determined by clicks 7-12, and a final right click. The 
angle lines of the satin stitch are created by the direction of the opposing nodes (i.e., 1-12, 
2-11, 3-10, etc.)
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B. The alternative method is determined in Tools>General Options>Digitizing when the 
options Use single line is selected. 
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After the right click, indicating the end of the shape, the cursor changes to a + with a 
black  attached.  The black circle symbol, creates the angle line(s). Click on one side of 
the object and drag the mouse to the other side of the line to set as many angle points as 
required.

Right click, when all of the angles have been set, to complete the process. Note how the 
varied angles are reflected in the stitches.
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 Applique
An “appliqué” is a sewing technique in which fabric patches are layered on a foundation 
fabric, then stitched with the raw edges covered with decorative stitching. From the French 
appliquer, “to put on.”

This functions has three parts:
1. Cut Line or Placement Line: This is a tracing with the use of a running stitch to guide 
the embroidery on where to lay down the fabric. A “Color Change” or “Stop command” 
is automatically added at the end of step one. The cut line is 50% from the edge of the 
cover stitch.

2. Tack Down Stitch: This stitch is a running stitch that holds down the fabric added after 
step one, (keeping it from shifting and moving around). The tack down stitch will automatically 
be moved in from the cut line approximately 50% between the edge of the cut line and 
cover stitch.

3. Cover Stitch: The cover stitch will edge the fabric patches to the foundation fabric. 
Note: The width of the cover stitch will default to 50% (i.e 50% on the fabric patch and 
50% on the foundation fabric). While this is appropriate for a satin cover stitch, it may 
need to be adjusted for E-Stitch, Motif, and other types of stitches.

How to Create
Select the Appliqué icon and draw or trace the shape in the preferred drawing method. 
(View>General Options>Digitizing for options.) The shape may be open or closed but must 
be appropriate to hold fabric. Designate the end of the drawing process with a right click.

When saving the applique design in your machine format, the applique design file will 
display a separate placement line, tackdown and cover stitch. When viewed in the native 
format, C2S, the file will display as an applique. It is understood the placement line, tackdown 
and cover stitch are there.

Appliqué Properties
Type - this is the type of stitch that will border the appliqué. You can use a Satin, Tackle 
Twill, E-Stitch, Motif, or Symbol stitch as a border.

Flip – this is available with Motif or Symbol types.

Appliqué width - this defines the width of the border.

Inset % - defines how much the border lies on the fabric and how much overlaps. The 
higher the number the more it lies on the fabric and the lower the amount of overlap--and 
vice versa.

Stitch length - this defines the length of the stitch used.

Pattern length - this is the length of the stitches used in the Motif and Symbol borders. The 
smaller the value, the smaller the pattern size.
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Appliqué density - the density of the stitches used in the border.

Angle - you can use this to slant or angle the border stitches of the appliqué.

Corner type - when using a satin stitch border this will allow you to extend the corners out 
or square the corners off.

Activation angle - this is the angle in which it will either square the corner or extend the 
corner depending on what is chosen for the corner type.

Placement line - when this box is checked, the machine will stitch a placement stitch to be 
used as a guide for applying the fabric.

Placement offset - this is the % of offset that will be used in the placement stitch. Usually this 
is kept at 0%, which is the original size of the appliqué design. This is also the same size to 
use for a precut fabric piece.
Tack down line - when this box is checked the machine will stitch a run stitch to tack the 
appliqué to the fabric.

Tack down offset - this is the % of offset that will be used in the tack down stitch (Default 25%).

Adjust holes - If the appliqué object has a hole (or empty section inside the appliqué 
piece), this will reverse the appliqué stitch settings and treat the hole in the same manner 
as the outer edge. See image below. (Default on.)
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Change colors - Default is checked, which will automatically add separate colors for the 
placement line and tack down line.
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Tackle Twill
Tackle twill is predominately a commercial term used to describe the application that is 
usually associated with sports uniform names and numbers. It is simply an appliqué with a 
type of zigzag stitch to hold the fabric in place.

How to create
Tackle Twill is created the same way a regular appliqué is created.

  

 Cross Stitch
This icon allows you to convert any object or artwork to a fill of cross stitches.

How to Create
Select the Cross Stitch icon and draw or trace the shape in the preferred drawing method. 
(View>General Options>Digitizing for options.) The shape may be open or closed. Designate 
the end of the drawing process with a right click.
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 Magic Wand

Magic Wand
The Magic Wand is only available when a backdrop is visible on the design page. The 
advantage of digitizing with the Magic Wand is that the outline drawing is done in a click 
and easily modified if necessary.

The following Stitch types are available to digitize with the magic wand and backdrop: 
Run (Standard, Two ply, Bean, Motif, Symbol, Projection, Double Rope, Triple Rope), Satin 
(Standard, Emboss, Contour, Whipped, Raised), Steil, Complex Fill (Standard, Emboss, 
Motif, Shape, Contour, Stippling, Wave, Radial), Appliqué (Satin, Tackle Twill, E-Stitch, Motif, 
Symbol), Cross stitch and Artwork.

Magic Wand with Other Stitch Options
With the Magic Wand and a backdrop, all the tedious work of manually outlining each 
object is eliminated.  The process is simple:

Step 1. Load and resize a backdrop image.
Step 2. Click on any of the available stitches and the Magic Wand (unless it was previously 

used and still highlighted, it is still active).  
Step 3. Select an appropriate color from the thread palette.
Step 4. Click the area to digitize. The process is complete, unless using a satin or complex 

fill stitch.  These two stitch types first display the outline nodes and the angle lines 
which may be adjusted.  When the adjustments are complete, click again to 
complete the process.

The following image is a sampling of different stitches created using the magic wand.  
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1. Appliqué, type: Satin, with fabric image
2. Complex Fill, type: Contour
3. Steil
4. Tackle Twill
5. Complex Fill, type: Standard, pattern: Tatami
6. Complex Fill, type: Emboss, pattern: 115
7. Run Stitch, types: Standard (top), Motif (lower)
8. Complex Fill, type: Wave
9. Cross Stitch
10. Complex Fill, type: Motif, pattern: 109

Magic Wand with Run Stitch Options
The Run Stitch option with the Magic Wand is a great choice for “magically” creating run 
stitch designs, such as quilting motifs and redwork (regardless of the color).

Load and prepare a backdrop. Click on the Run Stitch Icon and select the Magic Wand.  
Place the cursor on the black outline of the design, hold down the Shift key (and the magic 
wand will turn red), then click the outline.

The Magic Wand creates a single run stitch (i.e. redwork) in the center of the outline design.

The properties, such as stitch length and type, may be altered in the properties box if 
necessary. The design is complete.

If the wand is blue, the run stitch will outline the drawing, instead of a single path down the 
center.
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 Symbol
Click the down arrow and Select to display the symbol designs catalog. Input a single symbol 
or convert any run, border, or frame to a uniform repetition of the same symbol design.

Alignment Tools
Use the Alignment tools to position designs or portions of designs in specific arrangement. 

When using the alignment tools, use the  Select Tool to highlight the portions you want 
aligned. There are a few ways to select multiple elements.

If you want everything on the design page aligned:

1. Holding down your Left mouse button, drag a box around all the elements.

2. Click on “Ctrl + A” on the keyboard.

3. While holding down the Shift key, use the Select Tool  and click on each element.

Icon Function Shortcut Location Result in your 
design

Left align selected 
paths

Modify Tab. Arrange Box. 
Right Click Option.

Right align selected 
paths

Modify Tab. Arrange Box. 
Right Click Option.

Top align selected 
paths

Modify Tab. Arrange Box. 
Right Click Option.

Bottom align 
selected paths

Modify Tab. Arrange Box. 
Right Click Option.
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Icon Function Shortcut Location Result in your 
design

Vertical center 
align selected 
paths

Modify Tab. Arrange Box. 
Right Click Option.

Horizontal center 
align selected 
paths

Modify Tab. Arrange Box. 
Right Click Option.

Center align 
selected paths

Modify Tab. Arrange Box. 
Right Click Option.

Group selected 
paths

Ctrl + G Modify Tab. Arrange Box. 
Right Click Option.

Ungroup selected 
paths

Ctrl + U Modify Tab. Arrange Box. 
Right Click Option.

Move selected 
paths to Front

Ctrl + Shift 
+ [

Modify Tab. Arrange Box. 
Right Click Option. Flowers to 

Front

Move selected 
paths to Back

Ctrl + Shift 
+ ]

Modify Tab. Arrange Box. 
Right Click Option. Flowers to 

Back

Trim selected paths Modify Tab.  Shaping Box.  
Right Click Option

Weld selected 
paths

Modify Tab.  Shaping Box.  
Right Click Option

Intersect selected 
paths

Modify Tab.  Shaping Box.  
Right Click Option

Distribute Horizontal 
Spacing

Modify Tab.  Distribute Box.  
Right Click Option

Distribute Vertical 
Spacing

Modify Tab.  Distribute Box.  
Right Click Option
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TOOLS 
Create

 Auto Digitizing

This icon features a Wizard function which will create a stitch file from artwork. Select the 
Auto Digitizing icon for the Wizard box.  

Select the browse button. It will take you to the Images folder. Select an image.
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Select open. It will place the image in the path box. Select Next. In this window, you can 
make changes to the size and transform.

Select Next. In this window, you can make changes to the color(s). Uncheck any colors 
not wanted. You can preview the image. You can edit the image.

Select Finish. The wizard will transform your image into stitches.
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Remember the Auto Digitizing Wizard works well when the image or artwork is clean with 
defined areas. It is also a good starting point, and then changes can be made. If there 
is something you want to change, then you can select the stitch, right click, and convert 
to a different stitch. Or you select a different pattern in the type of stitch in the properties 
box. Refer to Creating Stitches section for more information. NOTE: Grid is on Hide. View, 
Grid, toggle off.  

 Stitched Snapshots

This icon will allow you to convert your photos into embroidery. Select the Stitched Snapshots 
icon to open the dialog box. 
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1. Locate your image on your computer, external storage device or the Stitched Snapshots 
Plus Images folder. 

2. Use video capture device on your computer. 
3. Smile and click the button. 
4. Adjust the width and the height of the image. 
5. Adjust the mode of color: color, gray, sepia, CMYK, Edge, Mono. Adjust how many 

colors you want (2 to 20). Hint: The higher the number in the Max color box does not 
mean Stitched Snapshots Plus uses all of them, you are giving permission to use up to the 
number of colors. Stitched Snapshots Plus adjusts to those parameters. 

6. Adjust the lightness and the contrast: slide back and forth to test your favorite look.
7. Mask: This tool allows you to change the outline of the image. Select shapes from the 

drop down menu or the browse button. 
8. Select Hatching or Stippling Style of stitching. 
9. The resolution affects how many stitches and how dense they are in an area. 
10. The thread chart allows you to select the thread brand. 
11. Use Show/Hide Preview to review the results of your choices. Click Show/Hide Preview 

button to redo your image. 
12. Use the OK button when you are pleased with the results and ready to save your project.

Select Browse to open an image from the Stitched Snapshots Plus Images folder. 
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Select the image and click Open. The image will appear in the window to the right of the 
options. 

In the sample below, the width and height are the same. Sepia is selected for Mode of 
Color. The Mask chosen is Ellipse. The Brand of thread is changed to Exquisite 40. 
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Choose Show/Hide Preview if you want to change your options. If you are pleased with 
the results, then click OK. The design will appear on the design page. NOTE: Grid is on Hide. 
View, Grid, toggle off.  

The design is ready to save and send to the embroidery machine for stitching. 

Image from Computer

Open a new page. Select the Stitched Snapshots Icon to open the dialog box. Select 
Browse to open an image from your computer. Find the folder of your images.  

Select the image and click Open. The image will appear in the window to the right of the 
options. The maximum of colors may change. The thread brand is changed to Exquisite 40.
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Select Show/Hide Preview. The stitched image appears in the window. Make any changes 
if wanted.

Select OK. The design will appear on the design screen. NOTE: Grid is on Hide. View, Grid, 
toggle off.  
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The design is ready to save and send to the embroidery machine for stitching. 

  Name Drops

This feature allows you to create multiple text designs. Select the design and place on 
design page. Next, select Text Tool. Type in name and select font. Select both design 
and text. Align if needed.
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Select Tools Tab. Select Name Drops. The following dialog box opens. Notice the name 
of the font is listed for both Text Style A and Text Style B. The Décor box shows where the 
design is located. Select the box with three dots to change the design.

Select LineA and type in name. If only using first name, then delete LineB. Select Preview. 
The name will appear next to the design. The Décor align default shows the design Left of 
the name. Use the drop-down arrow to select Right, Top, Bottom and Center.
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Continue adding names to the list. Change the Décor align. Select the name and Preview 
to see the changes. Notice the length of the name depends on how many letters are in the 
name. If you want the names to fit in line with the design, then select Fit in width method 
drop-down arrow. Shrink and Scale are additional options.

Select Shrink. Change the Max Width (mm).
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The other option in the Fit in width method drop-down menu is Scale. Select Scale. Leave 
the Max Width (mm).

The save option will become available when Create single file is unchecked. Create option 
is available when Create single file is checked. We want to have individual files for each of 
our designs and names for this example.
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Select Save. Select the folder on computer to save the designs or save to a USB stick. Type in 
the name of the design. Select machine format.

Select Save. The following box with the separate designs appears.

The designs are ready to stitch!
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 Cutter

The Cutter Tool organizes and assembles the outlines into cutting segments. The methods of 
cutting are variable and based on the user’s choice of tools:

• Digital cutter (or plotter) which produces precisely cut fabrics with minimal waste. 
• Embroidery machine with cutting needles which produces finished cut patches. 
• Embroidery machine with stitching which are manually cut by scissors or a rotary cutter 

after they are stitched. 
• Printed templates (on a variety of materials) placed on fabric and cut by scissors or a 

rotary cutter.

The Cutter dialog box includes the following options:

Hoop: Use the down arrow to select the appropriate hoop size from the options available. 
If the “hoop” size is not available, create a new hoop by selecting the hoop icon. Note – 
the hoop size could also be a paper or a cutting mat size.

Seam Allowance (in): Default is 0.00 inches. If the seam allowance is different, enter the 
appropriate number in the units and space provided.

Margin (in): Default is .25 inches. Enter the margin away from the edge of the “hoop” 
selected previously. 

Repeats: Default is 1. If cutting multiples of the same outline, enter the number of outlines 
here to make the best use of the “hoop” size.
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Fabric width (in): Default is 45 inches. Enter a different width of fabric if needed. 

Optimize position: Default is unchecked. Check if you want to make the best use of the 
position of the outline(s) to be cut. 

Optimize orientation: Default is checked. This will allow you to make the best use of the 
fabric or deselect to cut the outlines in the same orientation as the design. Note – the 
cutting files may be adjusted before cutting to orient the outlines to the grain line and/or 
pattern of the fabric. 

Apply: Click to implement the changes in seam allowance, margins, and repeats. 

Save: Click Save to implement the changes and view the cutting files.

 Repeat 

Use the Repeat tool to duplicate and evenly space the objects. You can control the number 
of repeats vertically and horizontally as well as the spacing between the objects and other 
options in the dialog box.

Click Apply and OK. The design will appear on the design page.
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 Carousel

The Carousel Tool repeats an object into a circle. You can control the size of the object in 
width (mm) and height (mm) under the Circle size. Checkmark the box Keep aspect ratio for 
a proportionate size. Adjust the number of repeats and the angle under the Settings area.

In the Individual path settings area, you can control the scale (%) in percentage and the 
angle. Leave the box Auto rotate unchecked if you want them going in the same direction. 
Default is the box is check marked as you see in the above photo. Also, there is a box to 
check if you have multiple colors and you want them to Auto resequence by color. Click OK 
and the design will appear on the design page.
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 Place

The Place Tool allows you to place the design in a chosen shape from the drop-down 
arrow. You can control the width, height, offset %, scale %, and check mark the box Auto 
resequence by color.

Click OK and the design will appear on the design page.
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 Reflect

The Reflect Tool mirrors an object horizontally and vertically. You can control the number of 
repeats, the angle, distance between the objects, and check mark the box Auto resequence 
by color.

Click OK and the design will appear on the design page.
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 Scatter

The Scatter Tool scatters the design in different sizes in the designated area. You can control 
the area, size of designs, rotate, and check mark the box Auto resequence by color.

Click OK and the design will appear on the design page.
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Change

 Optimize Sequence

This icon when selected will improve the stitching sequence of the design; reduces color 
changes.  

 Optimize Entry Exit

This icon when selected will improve the entry and exit points of sequential objects for the 
closest point connection.

 Color Sort

This icon when selected will re-sort the colors in your design to eliminate the “unnecessary” 
color changes. A word of caution: sometimes the repeated colors are there to optimize the 
details of the design. 
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Other

 Design Analysis

This icon will allow you to see the details, colors, statistics, and production of each design.
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 Batch Conversion

This icon will allow you to batch design conversion.  
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 Editors

This icon will allow you to access the following Editors: Palette, Standard or Font.

Palette
This Editor will allow you to open, add or import thread colors.  

Standard
This Editor will allow you to open or add stitches.
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Font Editor
The Font Editor feature allows the user to do the following: 

• convert an owned or purchased alphabet design collection to a keyboard embroidery font 
• create your own alphabet and turn into a keyboard embroidery font 
• add an alphabet design collection and turn into a keyboard embroidery font 
• use the TrueType fonts from your computer and turn into keyboard embroidery fonts 

The keyboard embroidery font will be accessible through the Text tool, making it possible 
to enter text in that letter style within the DesignDeck Embroidery Software.

NOTE:  The following stitch types are not available for conversion to lettering in the Font 
Editor: steil and outline (running stitch).  
 
Select the Font Editor. The following box appears.
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Choose and follow one of the four specific sections, depending on the type of font, you are 
adding.

1. CONVERT AN OWNED OR PURCHASED ALPHABET DESIGN COLLECTION TO A KEYBOARD 
EMBROIDERY FONT.

From the Font Editor box, click on NEW to add the alphabet design collection.

The following box appears.

• Choose a name for your alphabet.
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• Click the down arrow to change from True Type Font to “Stitch Designs”.

• Click the ellipse button (…) to the right of Folder. 
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The following box appears.

• Navigate to the folder where your alphabet design collection is located.   
Note:  You do not need to select a file from the folder as there may not be anything to 
select. We are selecting the folder where the files are located.  

  

• Once the folder is selected, then click OK.
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• Once the location is showing, then click OK.
• The following box will appear. You will right click on each letter icon to import the stitch 

designs.  

 
• Click OK for the dialogue box to disappear. 

NOTE:  There is NO batch conversion function so each character must be selected one 
at a time.

• You will notice the Font Editor dialogue box will reappear with fonts displayed.   
NOTE:  In the Other section is Reference Character and Line Spacing. 

Below the Other section is View with Show Characters.
• The Reference Character represents the distance used when pressing the space bar. 

The default character is “M” as it is the widest character, making it the most suitable as a 
reference.

• The Line Spacing default is set to 40% but is adjustable according to user preference. 
The value refers to the percentage of the character height. 

• “Kerning” and “Importing Spacing” are available for more advanced character space 
settings.

• Show Characters indicates which style of keyboard is being used. The default is Basic 
Latin. There is a drop down menu with additional options.
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• Right click on the “A”.
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• A dialogue box appears. Click on Import and a box with the folder of your alphabet 
design collection will appear.  

 

• Select the file for the represented font and click OK. 
NOTE:  There is NO batch conversion function so each character must be selected one 
at a time.
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• After all the characters have been imported, click “Save”.
• To close, click the “X” in the upper right corner of the Font Editor.
• Open the Text Tool and select your new keyboard embroidery font in the drop-down 

menu.
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• Type in the letters of your choice in the text box and select Apply. 
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• Toggle to Realistic View to see how the alphabet will stitch out!

• Select File, Save As, in the folder desired and type in file name, Click Save. Save for your 
machine format.

• Enjoy using the keyboard embroidery font in the software!

2. CREATE YOUR OWN ALPHABET AND CONVERT TO A KEYBOARD EMBROIDERY FONT

First, create your own font by digitizing it in the DesignDeck Embroidery Software or other 
digitizing software. Second, save the digitized font to your computer. Last, follow the 
step-by-step instructions from Section 1-CONVERT AN OWNED OR PURCHASED ALPHABET 
DESIGN COLLECTION TO A KEYBOARD EMBROIDERY FONT.

3. TURN A TRUE TYPE FONT INTO A KEYBOARD EMBROIDERY FONT

Download a free TrueType font or purchase one and install it to your computer. After 
the font is installed, select Font Editor. Then come back to this section for the remaining 
step-by-step instructions.
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From the Font Editor dialogue box, click on NEW to add the font.

The following dialogue box appears.

 

• Type a name for your keyboard embroidery font.
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• Click the ellipse button (…) to the right of the True Type box.

The following dialogue box appears.
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• Select the True Type font desired.  Click OK.  

• The True Type font name will appear in the box.  Click OK.
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The following dialogue box appears with the characters displayed.

NOTE:  In the note section, add any desired notes, such as who digitized the font.
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• Select the letter “A”.

          

• Double click on the letter “A”. The “A” opens on the design page. Move the Font Editor 
box to see the letter. 
NOTE:  The letter is artwork. The letter will need to be digitized.  

Reminder:  Steil and Outline (Running) stitches are not available for conversion. 

NOTE:  There is NO batch conversion function so each character must be selected one 
at a time.

• The green and purple lines are for controlling the position and spacing of the letter. For 
best results, the bottom of most characters should sit on the purple line. An exception is 
made for certain characters, such as some lowercase letters that descend below the 
line. Arrange the character so that it is pleasing to the eye also. Some characters may 
look better if some of the bottom of the letter is slightly below the purple line.

• The green lines define the spacing between the letters. The green line to the right of the 
“A” should be adjusted so the next letter isn’t on top of the “A”. Arrange the characters 
to be pleasing to the eye and consistent. You may want to test the spacing and adjust, 
if needed.
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• Select the letter.
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• Right mouse click on the letter. A dialogue box opens. Select Convert To and another 
dialogue box opens.  

 • Select the desired stitch type. Satin stitch is selected in this example.
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• With the character still selected, move the character so it is sitting on the purple line. 
Move the green line on the right so the right side of the character touches the line.

• Select Save and the character appears as stitches in the selected stitch type in the Font 
Editor window.  

• Repeat for the remaining uppercase and lowercase letters, numbers, and symbols.

• After the characters are all individually digitized and saved, they will all appear in the 
Font Editor window as stitches instead of outlines.  

• Click “Save”.
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• To close, click the “X” in the upper right corner of the Font Editor.
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• Open the Text Tool and select your new keyboard embroidery font in the drop-down 
menu.

• Type in the letters of your choice in the text box and click Apply.  
• If the spacing needs to be adjusted, go back to the Font Editor, and adjust the position 

of the green lines in relation to each character.  
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• Toggle to Realistic View to see how the characters will stitch out!

• Select File, Save As, in the folder desired and type in file name, Click Save and choose 
your machine format.

• Enjoy using the keyboard embroidery font.

4. USE THE TRUETYPE FONTS FROM YOUR COMPUTER AND CONVERT TO A KEYBOARD 
EMBROIDERY FONT

When you are ready to add another new font, the last one may still appear in the Font 
Editor window.
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• Select NEW, and a new Font window appears.
• Type a name for your alphabet.
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• Click the ellipse button (…) to the right of True Type: box.

The following dialogue box appears.  
• Select the TrueType font desired.  
• Click OK.
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The following dialogue box appears.
• Click OK.  

 

The previous font is replaced with the new font selection . In the Notes section, the month 
and year are indicated.
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• Select the letter “A”.

• Double click on the letter “A”. The “A” appears on the design page. Move the Font Editor 
box to see the letter.

NOTE:  The letter is artwork. The letter will need to be digitized.  
Reminder:  Steil and Outline (Running) stitches do not work.  
NOTE:  There is NO batch conversion function so each character must be selected one 
at a time.

• The green and purple lines are for controlling the position and spacing of the letter. For 
best results, the bottom of most characters should sit on the purple line. An exception is 
made for certain characters, such as some lowercase letters that descend below the 
line. Arrange the character so that it is pleasing to the eye also. Some characters may 
look better if some of the bottom of the letter is slightly below the purple line.  

 
• The green lines define the spacing between the characters. The green line to the right 

of the “A” should be adjusted so the next character isn’t on top of the “A”. Arrange the 
characters to be pleasing to the eye and consistent. You may want to test the spacing 
and adjust, if needed.
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• Select the character.
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• Right mouse click on the letter. A dialogue box opens. Select Convert To and another 
dialogue box opens.  

• Select the type of stitch and the artwork is converted to the selected stitch type. In this 
example, Complex Fill is selected.  

• In the Fill Properties, Smooth is the pattern selected. 
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• With the letter still selected, move the letter so the stitches are sitting on the purple line 
and move the right green line so the right side of the “A” is next to the line.

• Select Save and the letter appears as stitches in the Font Editor window.  
• Repeat for the remaining uppercase and lowercase letters, numbers, and symbols.

• After the characters are all individually digitized and saved, they appear in the Font
Editor window as stitches instead of outlines.  
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• Click “Save”.

• To close, click the “X” in the upper right corner of the Font Editor.
• Open the Text Tool and select your new keyboard embroidery font in the drop down 

menu.
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• Type in the characters of your choice in the text box and click Apply.  
• If the spacing needs to be adjusted, go back to the Font Editor, and adjust the green 

lines on each character.  

• Toggle to Realistic View to see how the new keyboard embroidery font will stitch out!

• To save your creation, select File, Save As. Choose the desired folder location and file 
Format. Type your desired file name and click Save.  

• Enjoy using the keyboard embroidery font in the software!
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View Tools

The following tools enable different methods of viewing designs, objects, stitches, commands, 
and other details of a design.

Icon Function Definition Special Note
Zoom Tool Left click on the icon to select the 

tool, then click on the design page 
to zoom in on a particular area. 
Tip: Double click on the icon to fit 
the contents of the design page 
on the screen.

Fit Tool Select the icon to fit the design in 
the window of the design page. 

1:1 Tool Select the icon to Zoom to 1:1 or 
100%. 

Pan Tool Select the icon, then left click and 
hold to relocate the display area 
of the screen.

Ruler Tool Select the icon, click and hold the 
left mouse button while dragging 
to measure an area on the screen. 
The measurement will be in the 
same units as the screen ruler.

Realistic View Click on the icon to toggle back 
and forth between regular view and 
a more realistic (three dimensional) 
representation of the design.

 Realistic View Regular View

Grid Select the icon to show or hide the 
grid on the design page.

 GridNo Grid

Stitch Ends Select the icon to display small 
points where every stitch will 
penetrate the fabric.

Commands Select the icon to display all 
machine commands within the 
design; including stop, cut, 
needle/color change, etc.

Color Change  & Trim Command
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Icon Function Definition Special Note
Hoop Select this icon to display one of the 

existing hoops or create a custom 
hoop size. Click again to turn off the 
hoop display. Tip: Applying a hoop 
to a design automatically centers 
the design in the center of the design 
screen.

Please see section below.

Slow Redraw 
Tool

Select to display the virtual sewing 
of the design. By manipulating the 
arrow keys and slider bar, it is possible 
to view the stitching sequence of a 
design before committing it to fabric.

Example shown below.

Guidelines

In addition to setting the grid to your specific settings, you can add horizontal, vertical, and 
angled Guidelines in a variety of colors.

Place the cursor on the ruler, click and drag away from the ruler to set a guideline. When 
moving the guide, the cursor will change to a double blue arrow. The double blue arrow 
tells you the only item that will move on the screen at that time is the guideline. Click away 
to release.

Right-click on the guideline to set the color, angle or remove the guideline completely. 
Guidelines are helpful for aligning objects.



138 DesignDeck Embroidery 139DesignDeck Embroidery

Slow Redraw
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Hoop Tool

The “Hoop” function gives you a visual reference of the design screen of several different 
hoop sizes of commercial machines.    

Using the Hoop Tool
When the Hoop icon is selected, the Hoop box appears with the following options:

1. Find: (default blank) Enter the brand name of a machine to list only the hoops 
available in the software for that machine brand. Leave blank to view the 
entire list.

2. The measurement of the selected hoop opening in millimeters.
3. A visual representation of the hoop selected.
4. Rotate: (default 0) Click the down arrow to select the number of degrees to 

rotate the hoop. Options include 0, 90, 180, or 270.
5. Suggest: Click the button to select the best hoop for the design on the design page.
6. New: Click the button to create a new hoop by entering the designated criteria.
7. Delete: Click to remove the selected hoop from the hoop list permanently. Only 

available for new hoops added.
8. Apply: Click to place the selected hoop onto the design page. This will automatically 

center the design in the hoop, and the hoop in the center of the design page.
9. OK: Click to close the window. This will also “Apply” the selected hoop.
10. Filter: Click to open another window to uncheck the hoops you do not want to view.
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Thread/Color Selection Bar

The color and thread selection tool bar is located under the design display screen.

When a design is opened, the colors for that design are displayed along with the default 
colors of the thread/color selection bar. When a new design is created, the tool bar is 
automatically populated with twenty default colors. Colors may be changed as required.

Color 1 is the currently selected color because it has a box around it. When an object is selected, 
its color is highlighted. If the object has multiple colors, no color boxes are highlighted.

To add more color options, left click on the  to the right of the color boxes.  To reduce 
the number of colors to only those colors in the currently displayed design, left click on the 

.

Change a thread color: 
Left click on the color on the color bar and the thread box appears:

The palette of colors for that thread brand appear, and the current color is highlighted as 
shown. To select a different color in the same palette:

• click on a different color square, or
• enter a number, or name in the Find box (1)
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Change a color palette by thread brand:
To select a color from a different thread palette, click on the down arrow in the 
Brand box. Then select the desired thread brand:

When the new thread brand is displayed, the highlighted thread displayed is the 
suggested match to the thread in the previous palette:

Add Color Click to add a color to the thread color bar. Color is set by default but may 
be changed.

Remove Extra Remove any thread colors not included in the displayed design.

Change Palette Select to change all of the displayed thread colors to a different brand, or palette.

Set Background 
Color

Select to change the background color of the design page. 

Insert Needle 
Change

Click to insert a color change to the selected object(s) in your design. Objects 
of the same color immediately after the selected object are also changed.

Insert Trim Click to insert a trim after the last stitch in the object immediately preceding 
the selected object.
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Sequence View

The Sequence View is a very powerful panel, which is often overlooked and underutilized. 
This window provides a snapshot of the entire design. In the Sequence View, the sewing 
order of the design may be altered. Click and drag a segment or design element into a 
different location. 

This panel provides a snapshot of the entire design, including:
• The stitching sequence of the design
• small view of each object and its color 
• A list of all stitch types used to create that element in the order in which it will sew out
• The number of stitches in that section of the design

Navigating the Sequence View Box

The Sequence View will quickly and easily allow you to turn on/off the view of a given 
segment. This helps greatly when editing objects or figuring out where all the elements of a 
given segment are in a design.

The Sequence View is also the area in which you change the sewing order of the design. 
You can click and drag a segment or design element into a different location by simply 
selecting it and dragging it into the desired location.
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Plus/Minus box – click to expand/collapse elements pertaining to the color.

 Eye Symbol – use this to turn on/off the view of the design element. When off, the design 
color segment is still in the design, but it is not visible and may not be selected or altered.

 Lock Symbol – use this to lock/unlock the design color segment in the sequence. When 
locked, the properties of that element may not be changed in any way.
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Move Elements – to move an element, left mouse click and hold the click while dragging 
the mouse to the desired location. Release mouse click when in the desired position.

Designs View

Designs View is a feature which enables a design to be added into any project on the open 
design page with a simple drag and drop. It is possible folders containing designs are already 
loaded in the library. Folders may be added to the designs view and designs may be added 
to existing folders.

The Designs View has two components.
•	 The Folders section which contains the designs. It is located in the upper section of the 

window. The folders contain the designs added and organized by the user.  

•	 The Design Viewer is located just below the folders. To access and view the designs, 
simply left mouse click on the folder. When the folder is selected, the designs will appear 
in the bottom section of the screen. Scrolling through the design viewer, displays all the 
designs located in that folder. Left click to select the design and hold while dragging it 
onto the design page. Release the mouse click. The design is now on the workspace.
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Folders

Right mouse click inside the Folders Section (the upper section) of the Designs View to display 
the menu. 

New Folder 
1. Click in Folders Section in the desired location for new folder. 
2. Right click and select New Folder. 
3. Type a name for the new folder. 
4. Designs may now be added to the newly created folder. 

Rename Folder 
1. Select the folder. 
2. Right mouse click and select Rename Folder. 
3. Type the new name in the name box. 
4. Click anywhere on the screen to apply the new name. 

Delete Folder 
The folder must be emptied of all files before it may be deleted. This precaution will help 
to ensure no folders are deleted accidentally and is a reminder to back up any necessary 
design files. 

1. Select the folder to be deleted. 
2. Right mouse click on the folder and select Delete Folder. 

The folder will now be deleted from your computer.
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New Link 
1. Select the folder.
2. Right mouse click; select New Link.
3. The browse for folder dialog box will appear on the screen. Select the folder on your 

computer or USB stick to link.

4. Follow the instructions to add the link to the folder.

5. The New Link will be added under the software folder and the designs will be seen in 
the window below.

6. If you want to rename the link or delete the link, right mouse click on the link folder. 
A dialog box will appear and give those options.

Show Contents 
1. Select the folder. 
2. Right mouse click; select Show Contents. 

The file contents box will appear on the screen.
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Refresh a Folder 
When designs are added to a folder, either existing or newly created, the designs will not 
display until the folder is refreshed or the next time the program is started. 

1. Select the folder.
2. Right-mouse click; select Refresh. 

Add Designs 
1. Select the folder for the designs. 
2. Right mouse click and select Add Designs. 
3. In the Open box displayed, navigate to the folder or drive on your computer which 

contains the design(s). 
4. Select the design(s) to add to the folder. 
5. Select Open. 

The designs are now inside the folder and ready to use.

Set Info
A designs info window appears to input information regarding the design. This information 
saves directly to the design file.
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Design Viewer

Select one of the designs in the Design Viewer (the lower section), then right mouse click 
to display the menu.

Delete Design 
1. Right click to select the desired design and display the dialog box. 
2. Select Delete Design. A precautionary pop-up box appears. 
3. Select Yes to delete the design or select No to keep the design. 

Show Contents 
1. Right click the lower section of the box to display the dialog box. 
2. Select Show Contents to open the file contents box.

Refresh 
1. Right click in the lower section of the screen to display the dialog box.
2. Select “Refresh” to redisplay the contents of the folder. 

Add Designs 
1. Right mouse click and select Add Designs. 
2. In the Open box displayed, navigate to the folder or drive on your computer which 

contains the design(s). 
3. Select the design(s) to add to the folder. 
4. Select Open. 

The designs are now inside the folder and ready to use.
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Set Info
A designs info window appears to input information regarding the design. This information 
saves directly to the design file.
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Properties Box

The Properties box contains all the settings for any properties of a selected design object, 
text, objects, or design. The design will need to be ungrouped to view the selected ele-
ments. The aspects for the selected elements may be modified by selecting the tab for 
the desired feature. Use the panel to view and modify the stitch type, stitch length, stitch 
density, design size, rotation, and position. 

The Properties box contains all the settings for any properties of a selected design object, 
text, objects, or design. The design will need to be ungrouped to view the selected elements. 
The aspects for the selected elements may be modified by selecting the tab for the desired 
feature. Use the panel to view and modify the stitch type, stitch length, stitch density, design 
size, rotation, and position. 

There are multiple Tabs within the Properties Box to adjust the aspects of your design.
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Design Tab 

The Design Tab will allow you to add notes, keywords, and rate the design. This is beneficial 
in the creating and stitching stage.  

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Text Tab 

The Text Tab in the Property Box has many options to change the appearance and characteristics 
of your text.

Height (mm): Sets the specific height for the letters in your chosen font. Fonts will show optimal size.

Space %: Sets the distance between the letters. Also, known as kerning.

Line Spacing %: Sets the distance between lines of text. Different types of fonts will require 
adjustments. For example, “y, g, h and t” are all letters taking more space above and below.

Reverse direction: Text will appear on the bottom of the circle when the “Reverse” box is 
checked in the Circle Type.

Optimize colors: When using multiple colors, optimize colors minimizes stops and jumps.

Italic or Stairs: By checking either or both of these boxes you can add a stair step or italic 
appearance to your fonts. *May not work on all fonts.

Order: Order allows you to stitch from Left-Right, Right-Left, Center-Right or Left-Center. 
Center-Right is optimal for hats or especially long lettering.

Shift: When using the “Path” type of text, you can have the Text ‘sit’ Above the Path, Below 
or have the letters centered in the middle of the ‘line’ that represents the path.

Text Window: The text window allows you to see all the fonts as they actually appear as they 
are listed in the drop-down box below it. If your text is selected on the design page, you can 
use your “Up” and “Down” arrows to scroll through them. To view the whole menu, hover the 
mouse over the font and left click. 
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True Type (TT): Select TT or True Type fonts by checking the box. When using True Type fonts, 
you will be able to choose to have them digitized using a satin stitch or have them appear 
as artwork.

Décor: There are several beautiful Décor designs for you to choose from to “decorate” your 
text accessible through Monogram Designs.

Align: Select Left, Center, or Right justification for lines of text. 

Type: This function allows you to turn any text into Normal (default), Circle, Spiral, Monogram, 
Path or Vertical.

 This brings up the Text Style Window. If you find you regularly use a font which you 
have changes for your specific needs, then you can save it here to use again.

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Artwork Tab 

Type: Choose from Outline, Fill, Artboard or Border using the arrow. Outline is a line drawing 
of the artwork. Fill sets the different colors inside the artwork. Artboard is an on-screen design 
surface. Border is along the edges.
Opacity %: Of the artwork. How transparent do you want the artwork?

Stroke width: The thickness of the line drawn around the object. All artwork load with a default 
stroke thickness of 1.00 pixels.

Stroke color: Change the stroke color when the Type is Fill by selecting the box, choosing a 
color, and then selecting the equal sign.

Dashes: Drop-down box allows you to choose none, dot, or dash for all the outlines of the 
artwork or selected outlines in the artwork.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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Applique Tab 

The Applique Tab will allow you to make choices about your applique. You can choose the 
type, applique width, stitch length, applique density, corner type, placement line, tack down 
type, adjust holes, and change colors.

There are several options under the type of applique. The properties may change depending 
on the type chosen.

Applique width: Default is 3.5 mm. This defines the width of the border.

Inset %: Defines how much the border lies on the fabric and how much overlaps. The higher 
the number the more it lies on the fabric and the lower the amount of overlap, and vice 
versa. Default is 50.
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Stitch length: Default is 3.5 mm. This defines the length of the stitch used.

Pattern length: The length of the stitches used in Motif and Symbol borders. The smaller the 
value, the smaller the pattern size.

Applique density: Default is 0.4. This is the density of the stitches used in the border.

Angle: In degrees for the direction of the applique stitch. You can use this to slant or angle 
the border stitches of the applique. Default is 0.

Corner type: Available in Square and Extended. This will allow you to extend the corners 
out or square the corners off.

Activation angle: Defaults to 45. This is the angle in which it will either square the corner or 
extend the corner depending on what is chosen for the corner type.

Placement line: Box is checked, which is the default. The machine will stitch a placement 
stitch as a guide for applying the fabric.

Placement offset: The % of offset used in the placement stitch. The default is 0, which is 
the original size of the applique design. This is also the same size to use for a precut fabric 
piece.

Tack down line: Default is run. Select from the drop down arrow. The machine will stitch a 
run stitch or none to tack the applique to the fabric.

Tack down offset: The % of offset used in the tack down stitch. The default is 25%.

Adjust holes: Unchecked, which is the default. If the applique has a hole or empty section 
inside the applique piece, this will reverse the applique stitch settings and treat the hole in 
the same manner as the outer edge.

Change colors: Unchecked, which is the default. Separate colors will not automatically be 
added for the placement line and tack down line. They will be the same unless the box is 
checked.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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Fabric Tab 

The Fabric Tab will allow you to choose a fabric from the Fabrics library. You can rotate, 
scale, and choose to select or deselect Global origin and offset options if desired. Click on 
the ellipse symbol to access the library.

Rotate: 0, 90°, 180° or 270°.

Scale in percentage %: Easily move the scrollbar in either direction.

Global origin: Default is selected. Deselect and the fabric will move accordingly. Offset X 
and Y in inches if desired. Easily move the scrollbar to the desired place.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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Fill Tab 

When an object is a satin, this Tab will allow you to use Standard Fill type with a choice of 
multiple fill Patterns.

Stitch Length (mm): Enter the length of stitch. Defaults vary by stitch type.

Density (mm): Enter the density, or closeness of the rows of stitching in mm. Defaults vary by type.

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Steil Tab  

The Steil Tab allows you to adjust different aspects of the steil stitch, which is a balanced 
column of uniform thickness/width.

Width (mm): Of the column of the steil stitch.

Angle: In degrees for the direction of the steil stitch. Default is 0.

Inset %: The percentage to the interior of the digitized line the stitches should be positioned. 
Default is 50.

Steil density (mm): The distance between the stitch points.

Corner type: Available in Extended or Square.

Activation angle: Defaults to 45. This is the angle in which it will either square the corner or 
extend the corner depending on what is chosen for the corner type.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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Run Tab  

The run properties box will allow you to change any run stitch types that are selected. 
There are eight types of run stitches available: Standard, Two Ply, Bean, Motif, Symbol, 
Projection, Double Rope, and Triple Rope. The changes vary by type.

Standard
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Stitch length (mm): default 3.0mm. To change, enter a new number.

Type: Standard. To change type, click the down arrow in the box and select from the options.

Random Length: Unchecked is default.  Check mark for random length.

Flip: (applies only to Motif & Symbol)

Pattern: (applies only to Motif & Symbol)

To make changes, click Apply.

Two Ply 

Stitch length (mm): default 3.0mm. To change, enter a new number. 

Type: Two Ply. To change type, click the down arrow in the box and select from the options. 

Random Length: Unchecked is default. Check mark for random length.

Flip: (applies only to Motif & Symbol) 

Pattern: (applies only to Motif & Symbol) 

To make changes, click Apply.
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Bean 

Stitch length (mm): default 3.0mm. To change, enter a new number. 

Type: Standard. To change type, click the down arrow in the box and select from the options. 

Random Length: Unchecked is default.  Check mark for random length.

Flip: (applies only to Motif & Symbol) 

Pattern: (applies only to Motif & Symbol) 

Bean repeats: default 3. To change, click down arrow and select number. 

To make changes, click Apply.
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Motif 

Pattern length (mm): current pattern length displayed. To change, enter a new number. 

Type: Motif. To change type, click the down arrow in the box and select from the options. 

Random Length: Unchecked is default.  Check mark for random length.

Flip: Unchecked is default. Check mark to change the direction of the motif or symbol. 
(applies only to Motif & Symbol) 

Pattern: current pattern displayed. To change the pattern, select the down arrow in the 
pattern box.
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Variable Size:  None is default.  To change the size, click the down arrow and select Linear 
increasing, Linear decreasing, Convex or Concave.  

Variable min & max %:  Default is 70% min and 150% max. To change, enter new numbers.
 
To make changes, click Apply.

Symbol 

Pattern length (mm): current pattern length displayed. To change, enter a new number. 

Type: Symbol. To change type, click the down arrow in the box and select from the options. 

Flip: Unchecked is default. Check mark to change the direction of the motif or symbol. 
(applies only to Motif & Symbol) 

Pattern: current pattern displayed. To change the pattern, click the down arrow in the 
pattern box, or select the box with ... next to it. 

Variable size: None is default. To change the size, click the down arrow and select Linear 
increasing, Linear decreasing, Convex or Concave.  

Variable min & max %: Default is 70% min and 150% max. To change, enter new numbers.

To make changes, click Apply. 
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Projection 

Stitch length (mm): default 3.0mm. To change, enter a new number. 

Type: Projection. To change fill type, click the down arrow in the box and select from the 
options. 

Flip: (applies to Motif and Symbol) 

Pattern: (applies only to Motif & Symbol) 

Density:  Default is 1.5mm.  To change, enter a new number.

To make changes, click Apply.
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Double Rope 

Stitch length (mm): default 3.0mm. To change, enter a new number. 

Type: Double Rope. To change type, click the down arrow in the box and select from the 
options. 

Flip: (applies only to Motif & Symbol) 

Pattern: (applies only to Motif & Symbol) 

To make changes, click Apply.
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Triple Rope 

Stitch length (mm): default 3.0mm. To change, enter a new number. 

Type: Double Rope. To change type, click the down arrow in the box and select from the 
options. 

Flip: (applies only to Motif & Symbol) 

Pattern: (applies only to Motif & Symbol) 

To make changes, click Apply.
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Underlay Tab  

The Underlay Tab allows you to adjust the underlay or the stitches which form the foundation 
of the design. 

• The shape of the underlay is defined by clicking one of the boxes. 
• Density(mm) is the spacing of the stitches. 
• Stitch Length(mm) is the length for stitches other than for Run stitches. 
• Run Stitch Length(mm) is for Run Stitches only. 
• Inset(mm) is the distance of the Underlay from the edge of the design. 
• Zig-Zag inset(mm) is the length of zig-zag stitches used in the underlay. 

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Pull/Push Properties  

The Pull/Push Tab is for adjusting the Pull/Push Compensation of the stitches. When embroidery is 
applied to fabric, the fabric is pulled inward in the direction of the stitching. Pull Compensation 
is a software function to counteract this inward pull on the fabric. It means how much pressure is 
being exerted on the stitches and how much it translates into distorting the fabric underneath.

You can set the pull compensation as Percentage, Absolute or None. 
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Percentage: The Percentage setting adds width to lettering columns based on adding a 
percentage of the original column width. 

Note: Using this method adds less width to narrow areas than wider areas, helping to retain 
the original proportions.
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Absolute: The Absolute pull compensation setting increases column width using a specific 
measurement set by the user to each side of the object.
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Push Compensation: Select the Side – none, Both, First/Second are the options from the 
drop down arrow. If choosing Both or First/Second, then the option to add and Absolute 
number becomes available.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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Blend Tab  

Blending is regular fill stitches of different colors, using first a regular fill density for your base 
color and a looser density running on top of the first in the same direction.

Fill in the boxes for the colors and select Gradient options: None, Linear increasing, Linear 
decreasing, Convex, or Concave.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.
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General Tab  

Connection: This include Sharp, Zig-Zag, Chiseled or Square using the drop-down arrow.

Chisel:  Default is 0.4 mm.

Gradient:  Options are None, Linear increasing, Linear decreasing, Convex, or Concave 
using the drop-down arrow.

Max. density (mm): Default is 2.00mm.

Overlap lines: Default is 1.

After changes are made, click APPLY to have the changes implemented. Note – the Enter 
key will work with some changes but is not universal.
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Column Tab  

The Column Tab allows you to regulate how Satin stitches are formed and appear in your 
design.

“Jagged” option: This will give your Satin stitches a “furry” or “icy” appearance depending 
on how your values are set. It will add nonuniform stitches along the specified edge. The 
Value will increase or decrease the amount of the uniformity.
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Split Satin type: This refers to Satin Stitches which are longer than 7mm. Once a satin stitch 
length exceeds 7mm, it has more of a chance of snagging or flailing. The satin stitch can 
be set to split with an Absolute value, Random value, or Percentage value.

Choosing different types of Satin Splits will allow different options on assigning value to the 
split.

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Commands Tab  

Set the start/end commands of design elements and change colors.

Color: Displays the thread color of the selected object (if only a single color is selected). 
The color can be changed by clicking on the up and down arrows. If multiple colors are 
selected, the display box is blank.

Start command: Click the down arrow in the box to select Normal, Jump, Stop, Frame out, 
Borer on, Borer off, Low Speed, High Speed, or Sequin as the first command of the selected 
sequence.

Normal (default) begins stitching.

Jump moves the hoop location without dropping the needle before stitching begins.

Stop forces a color change at the beginning of the stitch sequence.

Frame out moves the hoop (pantograph) to a location, specified in View Tab>General 
Options, and stops.

Borer on moves the frame so the borer is in the correct position.

Borer off doesn’t move the frame.
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Low speed will set the lowest speed.

High speed will set the highest speed.

Sequin moves the frame so the sequin is in the correct position.

End command: Click the down arrow in the box to select Normal, Jump, Trim, Stop, Frame 
out, Borer on, Borer off, Low speed, High speed, or Sequin as the last command of the selected 
sequence.

Normal (default) begins stitching.

Jump moves the hoop location without dropping the needle before stitching ends.

Trim forces a thread trim before stitching ends (but only if the machine has a thread trimmer).

Stop forces a color change at the ending of the stitch sequence.

Frame out moves the hoop (pantograph) to a location, specified in View Tab>General 
Options, and stops.

Borer on moves the frame back at the end so the borer is in the correct position.

Borer off doesn’t move the frame.

Low speed will set the lowest speed.

High speed will set the highest speed.

Sequin moves the frame back at the end so the sequin is in the correct position.

Tie in: Click the down arrow in the box to select None, Basic, Triangle or Line as the first 
sewing command of the selected sequence. The function (except for None) is to lock the 
thread in place so it won’t unravel.

None does not perform a tie to “lock” the thread in place and would be a good
option for basting.

Basic takes a few stitches back and forth on the stitching line before proceeding
with the stitching.

Triangle creates a tiny triangle lock before beginning the stitching sequence. 

Line takes a few stitches back and forth on the stitching line before proceeding with the 
stitching.
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Tie off: Click the down arrow in the box to select None, Basic, Triangle, or Line as the last 
sewing command of the selected sequence. The function (except for None) is to lock the 
thread in place so it won’t unravel.

None does not perform a tie to “lock” the thread in place and would be a good
option for basting.

Basic takes a few stitches back and forth on the stitching line before ending
with the stitching.

Triangle creates a tiny triangle lock before ending the stitching sequence.

Line takes a few stitches back and forth on the stitching line before ending with the stitching.

Text Commands

Trim longer than 2.0mm: (Default) Choose from none, chars, words, lines, capitals and 
longer than. Change the length for longer than if needed.

Color change: Options are none, chars, words, or lines.

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.



180 DesignDeck Embroidery 181DesignDeck Embroidery

Advanced Tab  

Change Density:  Default is 100.  Change if needed.

Change Stitch Length:  Default is 100.  Change if needed.

Change Run Stitch Length: Default is 100.  Change if needed.

After changes are made, click APPLY to have the changes implemented. 
Note – the Enter key will work with some changes but is not universal.
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Transform Tab  

Use transform options to resize designs, change position of X & Y, rotate designs a specific 
number of degrees, mirror or flip designs or design objects. Select all or part of any design 
on the design screen. The selected object(s) may be modified as follows. 

Width (mm): Enter the measurement to change the width of the object. The unit of 
measurement (inches or millimeters) is determined by the setting on the grid ruler. Or 
enter a percentage to increase or decrease the width of the object. 

Height (mm): Enter the measurement to change the height of the object. The unit of 
measurement (inches or millimeters) is determined by the setting on the grid ruler. Or enter 
a percentage to increase or decrease the height of the object. 

Maintain aspect ratio: Default is checked. To change the width or height of an
object independently (not proportionally) of the other, uncheck this option. 

Regenerate stitches: Default is checked. It will increase or decrease stitches according to 
adjusted increase or decrease of the design width and height.

Position X: The X position on the screen.

Position Y: The Y position on the screen. 

Rotate: Enter a number of rotation degrees in the box. The number can be either positive 
or negative.

Mirror: Check to mirror the selected object/design side to side from its original position. 

Flip: Check to flip the selected object/design up and down from its original position.

After changes are made, click APPLY to have the changes implemented.
Note – the Enter key will work with some changes but is not universal.


